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Chapter 1

What is Places?
Places for Project Teams is a new tool for team communication and information
management. Places is designed to provide a structured, intuitive layout for
project information as well as fostering team communication through group
awareness of a team's progress. Groups of people can discuss, design, and review
ideas about their project without leaving their offices. A feature called Active
Presence allows you to see who else is in the Place and to send a direct message
to them or view their electronic Business Card. Places aims to bring teams
closer together.

Places for Project Teams provides several important advantages towards
achieving effective team communication:

• Customization: Places for Project Teams is composed of Places
components that can be customized as required for your project. Give your
meeting Place a name, share it with selected colleagues, set your own
milestones and Topics. Create as many Places as you have projects.

 
• Intuitive Information Management: Places for Project Teams provides an

intuitive approach to document storage, organization, and navigation.
Information is recorded and displayed across a timeline, so anyone on the
team can view the team's information, discussions, and feedback by moving
chronologically backward and forward through the Place.

 
• Note Review: Team members share notes related to a project, review them,

and give feedback from the project Place's virtual workspace. Notes can be
reviewed by Topic, by date, or by author. You can respond to contributions
made by other members of the group, create an entirely new article, or share
documents.

 
• Collaboration:  Team members communicate more freely by using notes, e-

mail, and shared documents to carry their message. Active Presence lets you
see who else is currently using the Place and send them an Instant Message.
In this way, teams can take advantage of each other’s virtual presence; just
as if they had started a conversation in the hallway.

 
• Business Cards: Create Business Cards for all team members listing their

fax, phone, and e-mail address. The address provides an electronic link so
you can automatically route messages to any member of the team by using



What is Places?

1–2    PLACES

their Business Card.  Some of this information is Place specific.  You can
see what role other users have and what their responsibilities are.

 
• Lotus Notes Database: Places for Project Teams provides easy access to

information you already have stored in Notes discussion databases as well as
new information you want to integrate.
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About This Manual
The PLACES for Project Teams User Manual describes the procedure for
installing Places and how to use it for everyday project communication.  Before
using this guide, it is important that you be familiar with the Windows NT or
Windows 95 operating system.

Related Documentation
For additional information, refer to the Lotus Notes User Guide for information
on establishing a user account.

The Lotus Notes User Guide document is not required to install and use Places
for Project Teams.  However, you may find it useful for additional background
information.
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Chapter 2

Installing Places
This chapter lists the requirements for installing Places for Project Teams and
the steps required to install it.

Installation Requirements
Before installing Places for Project Teams, you must have the following:

� Lotus Notes version 4.0 or greater running on Windows 95 or
Windows NT version 3.51 or 4.0

� At least a 486 processor, 90 MHz Pentium or greater recommended

� At least 16 MB of memory, 24 MB recommended for NT

� At least 15 MB free space on system disk to install (6 MB used
permanently, the rest is used temporarily for installation only)

� SVGA color monitor with at least 256 colors (16-bit color is
recommended)

� Printer (optional)

� Lotus Notes accounts for all project team members

Note:  Typically a client who uses Notes has access to at least one Lotus Notes
server through the network.  A Notes server, however is not strictly required
since a Notes client can be configured to run as a stand-alone product.  Places in
this type of configuration is limited to use on a single machine and cannot be
shared with others.
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Installation

Before installing Places for Project Teams, make sure Lotus Notes has been
installed and runs on the target computer.  Your Places account and password
will be the same as your Lotus Notes account and password so the Notes account
must be valid and active.  The account number and password can only be
changed in Notes.

A word about Lotus Notes: all members of a Place must have at least author
access to the Notes discussion database, otherwise the user will be unable to post
notes in Places.  If a user account does not exist or lapses, Places will continue
and may appear to work, but most operations will produce an error message and
content will be missing.

Note: The steps below explain how to install Places on Windows 95 or
Windows NT 4.0.  On computers with Windows NT 3.5.1 installed, the
procedure is similar to that of Windows 95.  In general, instead of the Start
Menu in Windows 95, Windows NT 3.5.1 users employ the Program Manager.
Instead of a Taligent Places item being in the Program menu, there is a Taligent
Places Program Group in Windows NT 3.5.1.  Otherwise, the steps involved are
the same.

Install Places for Project Teams as follows:

1. Install the CD-ROM into the drive and open the CD-ROM directory
or
Download the setup file from the Taligent web site.

2. Double-click Setup.exe to start the installation.
3. When the Places for Project Teams installation wizard appears, follow the

wizard instructions.

• To do a typical, default installation, you will not need to type anything
during the installation process, just press Next until it is finished.
Places will be installed on your C: drive and will include the Places
software, user guide, and two sample places, Latte Lounge and Places
Product Sheet.

• Optionally, you can change the location where Places will be installed.
Press the Browse… button on the Choose Destination Location screen
to install in a different location.

Note: If you change your mind about the location AFTER it has been installed,
you should use the Windows Uninstall program and reinstall in the desired
location.  DO NOT try to move the Places directory.
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• Optionally, you can choose which pieces you want to install.
-  Typical install: Places software, User Guide and the two sample
places.
-  Compact install: only the Places software (no User Guide or
samples)
-  Custom install: choose the pieces individually.
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Chapter 3

Using Places

How do I get to a Place?
A Place is a shared work and information space for a team, and you may have
access to several Places. When you start Places the first thing you will see is the
Directory  which lists all the Places you have access to. For a Place to be listed,
you need a PDS (Place Data Source) file for that Place in the Places folder on
your computer. To start a new Place you can make your own PDS file by
creating a Place with the Place Maker Wizard, or join an existing Place by
getting a PDS file from someone else (like our sample Places).

Starting Places

Note: The steps below explain how to start Places on Windows 95 or NT 4.0.
On computers with Windows NT 3.51 installed, the procedure is similar to that
of Windows 95.  In general, instead of the Start Menu in Windows 95, Windows
NT 3.51 users employ the Program Manager.  Instead of a “Taligent Places”
item in the Program menu, there is a Taligent Places Program Group in
Windows NT.  Otherwise, the steps involved are the same.

1. Click the Start button from the Windows 95 task bar.
2. Select Programs from the “Start” menu.
3. Select Taligent Places from the “Programs” menu.
4. Select Places for Project Teams.

Note: These will be your selections if you used the default installation. If you
chose a different folder you should look for Places for Project Teams in that
location.
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The Directory

When you open Places, the Directory window appears as shown below:

 
The Directory contains Place descriptions and PDS file names. It also shows the
date when the Lotus Notes database for each Place was last modified. An * is
displayed if a Place has changed since your last visit. Click on any of the column
headings to sort the list by that category (eg Last Modified)

 
1. Select a Place, for example, Places Product Sheet or Latte Lounge.
2. Press Take Me There, or double click on the Place Description.
3. Type in your current Lotus Notes password when requested.
4. You will see the Timeline View for the Place you entered.

 Use the Refresh button to check for updates.

Once you are in a Place, you may go to any other Place listed in the Directory.
Select the Directory button, or Place: Open Directory menu item.
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Creating and Accessing Shared Places

Because Places uses Lotus Notes discussion databases, you will need both a
Lotus Notes database file (NSF) and a Places file (PDS).  You can create and
access shared places in three ways:

• Create a new Place with a new Notes database using the Place Maker
Wizard

• Create a new Place from an existing Notes database using the wizard
• Connect to an existing Place PDS file by copying it to your Places folder

When you create a new Place and want it to be shared with other people, you
will need to make the Notes database and the Place PDS file accessible to others.
Typically the Notes database will reside on a shared server that others have
access to, then you can make your new place known either through an e-mail or
via a note in an existing shared place with the PDS file attached.

Creating a New Place

You create a Place by using the Place Maker Wizard  to make a PDS file which
links to a new, or an existing, Lotus Notes discussion database.

Open the Place Maker:

1. Click Start, Programs, Taligent Places

Note: These will be your selections if you used the default installation. If you
chose a different folder you should look for the Place Maker in that location.

 
2. Select Place Maker to launch the wizard

Note: You will see a warning message each time you start the Place Maker to
remind you that all Lotus Notes applications need to be closed first. This
includes both Notes and Places.   This is normal and always as a reminder.
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The Place Maker wizard will ask you whether you want to create a new Place
and a new database, or create a Place which connects to an existing database:

3. Select Create a new Place and a new database.   Click Next.

4. Place Maker will ask you for the name of the server.  The default is local
(your machine), but if you want others people to use the Place you will need
to use a shared server.   Click Next.

Note: You must have a Lotus Notes account on all servers where you wish to use
or create a Place. To create a new Place you must also have the correct access
privileges.  See your Notes Administrator if you do not have the correct access.
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5. Enter a descriptive name for your Place file. This name will be displayed
later in the Directory . As you enter this name the wizard will automatically
enter the system file name (PDS), together with the Notes Database (NSF)
file name if it is a new database. You can create a long descriptive name and
then edit the file names to be shorter by clicking on the Change button.
Click Next.

6. The wizard will begin creating the PDS and NSF files.  You will be asked to
enter your Lotus Notes password.

7. Start Places for Project Teams and see your new Place in the Directory.

Creating a New Place from an Existing Lotus Notes Database

Creating a new Place from an existing Lotus Notes database is a very similar
procedure to creating a new database and uses the same Place Maker wizard.
See above for more details on each step.

Open the Place Maker:
1. Click Start, Programs, Taligent Places
2. Select Place Maker to launch the wizard
3. Select Create a Place using an existing database.
4. Select the name of the server containing the database to which you want to

connect.  (If no server name is selected by default, click on the arrow button
to display a list of available servers.)  You will be prompted for your Lotus
Notes password. The wizard will display a list of the available databases.
Select the one you wish to use.
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5. Enter a name for your Place.   Since you are connecting to an existing NFS
file, this screen only allows you to enter a PDS name.

6. Your PDS file will be created and you will be prompted for your password.
7. Start Places for Project Teams to access your new Place.

Connecting to an Existing Place

In order to connect to an existing Place, you will need access to a Places PDS
file.  If someone has already created a PDS file, they can email it to you, you can
retrieve it from a shared folder, or you can copy a PDS file that someone has
added to an existing Place through an attachment or the External Document
List .

To go to a Place which someone else has created:

1. Copy the PDS file into your Taligent Places directory.  (If you did not
change the default location when you installed Places, the Place directory
will be C:/Program Files/Taligent Places.)

Note: Several Places (PDS files) can link to the same database. You can also
connect to an existing Lotus Notes database even if you do not have a PDS file.
(See Section Creating a New Place from an Existing Lotus Notes Database)

2. Start Places for Project Teams.
3. The new Place will now be listed in your Places Directory.
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 What can I see in the different views?
Places gives you four unique perspectives on the same information:

• The Timeline View

• The Newspaper View

• The Outline View

• The People View

Each view is useful in different ways, and provides special functions. The
Timeline View arranges information across time, within Topics, and provides a
high-level view of the information.

The Newspaper View enables you to focus on greater detail, and read groups of
notes selected from within the other views.

The Outline View shows the thread of responses within Topics, while the People
View shows who has written which notes, and on what Topics.

The Timeline is the default View, and is always displayed when you first open a
Place. You can reach the other views from the View menu, or by using the
buttons in the top right of the window.
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The Timeline View

The Timeline View window, shown in the illustration below, is the main window
used by Places for Project Teams:

 

People Here

The People Here area shows all of the users currently in this Place. This is also
referred to as Active Presence.

 When a user opens a Place they are considered to be ‘in’ that Place. Their name
is visible to everyone else who is also in that Place, and a colored icon shows
their level of activity. The icon is blue when they are currently viewing Places. If
they open, or select, a different application it will change to gray, or inactive.
Active Presence is designed to give users an awareness of other people’s
presence and to foster group communication.
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 When there are more people in a Place than can be shown at once in the
available space, arrows will appear to enable you to scroll through the entire list.

You can double-click on any person’s name to display their Business Card. (See
How Do I find Out about other People in the Place)

Timeline Area

The main part of the view contains the Timeline. It is a scrollable area that
graphically displays all Topics, messages and notes chronologically in the
current Place. Notes are grouped in Topics which are listed alphabetically in the
Topics Area.

You can move the Timeline chronologically forward and backwards by clicking
with the mouse anywhere in the timeline and dragging the mouse left or right.
(The cursor will look like a double arrow). You can also scroll by week using the
arrow buttons in the top left corner under the year.

Colors and Symbols

Colors and symbols on the Timeline indicate the following:
• A Vertical purple line indicates a milestone set by using the Edit: Milestones

menu.  Milestones can be set by a user to mark any date for any purpose and
are seen by all users.  To see a milestone’s name, move your mouse over the
purple block on the calendar headings. (See Creating Milestones)

 
• Discussion Bars are horizontal gray bars on the Timeline which represent

the duration of the discussions listed in the Topics Area.  Dark blocks on the
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gray bar indicate that one or more notes were created on the same day for
that Topic. These are note blocks.

 

 
 
• Each note block in a Discussion Bar shows the number of items that were

added to a Topic on that date. A solid blue or orange block indicates one
note, and white lines are drawn as more notes are added to indicate a ‘pile’
of notes.

 
• Orange blocks indicate unread notes.
 
• Blue blocks indicate notes you have previously read.
 
• As the mouse pointer moves over a note block, the name and author of the

note appear in a flyover list.
 
• Single click on the note block to ‘pin’ the list in place and to see the scroll

bar. Single click on any note in the list to open one note.
 
• Double clicking on a note block or a Topic will open that group of notes in

the Newspaper View.
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Topics Area

The Topics Area of the Timeline View window displays an alphabetical list or
index of all Topics entered by users of the current Place.  The Topics bar is
scrollable when the number of Topics exceeds the height of the bar.

The Topics Area can be moved left or right along the whole extent of the
timeline to line the Topics up with the notes (by clicking and dragging with the
mouse).  To return the Timeline View area to the current date quickly, click on
the yellow date box, at the top of the Topics area, next to the date.

Each Topic is shown as a Discussion Bar on the timeline, containing notes
posted by any member of the team.  The bar also shows when the first and last
note were posted for that Topic. Selecting a Topic causes the whole Discussion
Bar to be highlighted and the notes for that Topic to be listed in the Summary
Area.
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Summary Area

The Summary Area at the bottom of the screen displays information and status
about the items selected in the adjacent view, such as shown below for the
Timeline View. When you first open Places the Summary Area will list All
Notes in that Place.

• Click the column label (Title, Attachment, Author, or Date Created) to
display the items by date or in alphabetical order based on the label.  Click
on the column label again to reverse the order. (A triangle will appear next
to the column heading to indicate that the notes are sorted by that column. It
also indicates the direction of the sort. Pointing upwards indicates a forward
sort, pointing downwards indicates a reverse sort.)

• The Summary Area can be resized upward to view more documents by
clicking and dragging on the horizontal border, or you can use the scroll
bars.

• Select Unread Only to display only the unread items from your current
selection in the Summary area.

• Click on a person’s name in the Summary Area to open their Business Card.

• Click on an attachment icon to save or open a document attached to a note.

• Click on a note’s title to open an individual note.

If you want the Summary Area to show all notes again, select the All Notes
button, or the Edit: Select All Notes menu item.
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The Newspaper View

Open the Newspaper View using the View Menu, or the Newspaper View
Button, or by double clicking on a note block or Topic. The Newspaper View
displays multiple notes in columns - it looks like a Newspaper! You can scroll
through the columns or move page by page. It is a good way to read through all
the notes for one Topic, or browse through your unread notes.

The Newspaper view will open with all the notes that are currently selected;
which are listed in the Summary area. You can open all notes, though that may
take some time. Notes can be selected in the following ways from the Timeline
View:
• All unread notes (Ctrl key + Newspaper button, or View: Unread News

menu item).
• All notes (using Select All Notes).
• All notes in one Topic (by selecting a Topic in the Topics Area).
• All notes for a Topic on one day (by selecting a single note block on the

Timeline).
• A single note (by double clicking on a single note).
• All notes that contain a common text string (using Find).

Notes can be selected in the following ways from the People View:
• All the notes by one person (you can also use Find).
• All the notes on a single Topic by one person.
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Scrolling and Paging
You can move through the notes by scrolling or paging:

The arrows at the top left and bottom right of the screen scroll the columns in a
snaking movement, either forwards or backwards.

The larger (outside) arrow moves the text by one note at a time. This can be a
lot, or a little, depending on the length of the note. The smaller (inside arrow)
moves the text by one line at a time.

When the arrow shows as a lighter gray, you cannot scroll any further.

You can use these arrows to move back and forth through the newspaper by one
page at a time.

 Click on the minus sign in the note or Topic heading to collapse the note or
Topic.

 Click on the plus sign in the note or Topic heading to expand the note or Topic.

Note: If you collapse a note in the Newspaper View, it will continue to be
collapsed every time you open that view until you chose to expand it again.
Collapsed notes are not shown when you print a document (see Printing
Multiple Notes).
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The People View

To find out who is the most knowledgeable about a Topic, or who has written the
most notes on a Topic, or perhaps to find a note when you can remember who
wrote it, but not which Topic it was under, use the People View.

Select the View: People View menu item or click the People View button.  The
People View window appears similar to the following:

The People View shows a matrix of all Topics in the Place (vertical axis) versus
all contributors to those Topics (horizontal axis).  The number of responses per
Topic and total per individual are displayed.

• The number of notes is indicated by color. A lighter yellow indicates fewer
notes, a darker red shows larger numbers of notes.

• As you move your mouse over the grid the full name of the person is
displayed to the top left, and the Topic name moves to the right in the Topic
List.

• Click on a cell in the grid to list the notes by person or Topic in the
Summary Area.

• These selected notes can also be viewed in the Newspaper View by
selecting Newspaper View from the View menu or selecting the Newspaper
View button, or by double clicking on the cell.
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The Outline View

The Outline View shows the entire database of notes arranged hierarchically.
Access it from the View: Outline View menu, or the Outline View Button.

This view provides a way to trace responses as they occurred for a given Topic.
• Click on the symbol to open/close the branch.

• A + plus symbol indicates an unopened branch.
• A - minus symbol indicates an opened branch.

• Click on the note to open it and display the contents at the bottom of the
screen.

• Double-click to open the note in a separate window.
• An entry with a red dot next to it indicates that this is an unread note.
• There are three buttons on this view:

• Expand All - Expand all branches of the outline; toggle to Collapse All.
• Expand One - Expand the current branch.
• Next Unread - Move to the next unread note (indicated by a red dot).
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 Note: While the Outline View is filling in the discussion thread you can
select Cancel to stop its progress. Use the Refresh button to redraw it again. The
Refresh button will also be enabled if a note is added to the Place.

The large buttons to the right of the Outline View window show the title and
author of each note in the thread of responses, with the note you selected listed at
the top.  If that note is a response, then the previous note in the thread is listed
below, with the first note in the discussion at the bottom. Click on one of these
buttons to open the individual note.
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How do I Read a Note?
A note can be opened from any view in the Place. Any individual note can be
viewed in its own window, or groups of notes can be read together in the
Newspaper View.

Timeline View

To view a note in this view, use the following steps:
1. Move the cursor over a gray discussion bar.  As you do, a list of notes in

each Topic appears in a flyover menu.
2. Double click on a note block to display all the notes for that day in the

Newspaper View.
 or
 Single click on the note block to ‘pin’ the flyover menu, then click once

more to select a single note from the menu and it appears in a separate
window.

 Single click within the gray bar to select all notes in that Topic.  Select
Newspaper View to read all of them, or double click on the Topic name to
open the Newspaper View.

People View

From this view, notes can be viewed by Topic and author. To view a note in this
view, use the following steps:
1. Click on the grid square where the initials of the author and the Topic list

intersect.  A list of notes written by this author appear in the Summary Area
at the bottom of the screen.  If no notes are shown there, this person has not
posted notes on this Topic.

2. Select the note you want to read in the Summary Area and double click to
open it.
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 or
3. Double click on the cell to open all the notes in the cell in the Newspaper

View.

Outline View
1. Select a note on the hierarchy.  Every note you select in the Outline View is

automatically opened and displayed at the bottom of the view window.

2. Any individual note can be opened in its own window (for printing or
responding).  The large note button to the right of the Outline View shows
its date and author.  Click on this large button to display the note in its own
window.

Newspaper View

Double clicking on a note or group of notes in another view will open the notes
in the Newspaper View.
1. Use this view to read individual notes or groups of notes.  Groups are

categorized by content, date, author, or Topic.
2. You can use the Unread Only checkbox in either the Summary Area or the

Newspaper View to see just the unread notes from your selection, or to see
all the notes.

3. To read all the unread notes in a Place, hold down the Ctrl key while
clicking on the Newspaper View button, or the View: Unread News menu
item.
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How do I Write a note?
When you post a note in Places you can either respond to a Topic, or respond to
a note which someone else has written  in a Topic. The difference between these
two types of response will only be evident in the Outline View, where the
relationship between notes is displayed.

Alternatively, you can start a completely new Topic when you have a new
subject to be discussed by the project team.

Responding to a Topic

You can create a new note within an existing Topic from any view. To respond
to a Topic in the Timeline View follow these steps:

1. Select a Topic by highlighting a Topic name, or clicking on the light gray
area between the note blocks which forms the Discussion Bar.

2. Select the Respond to Topic button, or from the Place menu, select Respond
to Topic.  The following window appears:

 

 
 

3. Type in a title and add a note to the Topic about its subject.

 Note: There is an 80 character limit for the titles of notes.

4. To attach a file to your note, select Edit: Attachments…, or click on the
Paperclip button. Select a file from the Attachments dialog box.
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5. Click the Post button or select Post from the File menu.
6. You can edit any note in Places, if you were the original author. You cannot

edit a note someone else has written.

The new note appears on today’s date on the discussion bar for that Topic in the
timeline. It will appear to you as a blue block (previously read), and an orange
block (an unread note) to other people in the Place.

Note: If you edit a Note in Lotus Notes rather than Places it becomes read-
only in Places.

Responding to a Note

To make a comment, provide additional information, or continue the discussion
further, you can respond to individual notes.  To do this in the Timeline View,
use the following steps:

1. From the Timeline Area or the Summary area, select a note to which you
wish to respond. Click the Respond to Note or the File: Respond to Note
menu item. The following note editor appears:

 

 
 

2. Type in a title for the note of up to 80 characters.
3. Type the message.
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4. To attach a file to your note, select Edit: Attachments… and select a file
from the dialog box, or click on the Paperclip button.

5. Click the Post button or select Post from the File menu.
 

The new note appears on today’s date on the discussion bar for that Topic in the
timeline. It will appear to you as a blue block (previously read), and an orange
block (an unread note) to other people in the Place.

Creating a New Topic

Creating a new Topic uses almost the same procedure as responding to an
existing Topic, except it creates a new item in the Topics Area. To create a
Topic, use the following steps:

1. From the Timeline View, select the Add a New Topic button or from the
Place menu, select New Topic.  The following window appears:

 

 
2. Type in a title and if desired add a note to the Topic about its subject.

Note: There is a 40 character limit for the names of Topics.

3. Attach Documents in the same way as for a response to a Topic.
 

 4. Click the Post button or select Post from the File menu.
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The new Topic appears in the Topics Area on the Timeline, in alphabetical
order.  The Discussion Bar will show one note block on today’s date.

Printing Notes
You can print notes individually or in selected groups, by Topic, by author, by
the selection in the Find box, or by selecting the entire Places database: All
Notes.

Printing Single Notes

To print an individual note, use the following steps:
1. Select and open a note.  (Refer to How Do I Read a Note? for directions on

opening a note from different views.)
 

 
 

2. From the File menu select one of the following:
• Print - Provides the standard Windows print dialog box to print the

note.
• Print Once - Prints the note immediately without showing the print

dialog.
• Optionally, select Page Setup to set page size, orientation, and margins

to be set.  If you don’t do this, default page settings are used.

Printing Multiple Notes

To print all notes by Topic, date, content, or author, use the following steps:
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1. Open the notes or group of notes to be printed in the Newspaper View (see
the Newspaper View for an explanation of selecting different groups of
notes)

2. To limit the notes to only unread ones, click the Unread  Only button at the
top of the Newspaper View window.

3. All notes will be printed exactly as they appear on the screen (collapsed or
expanded).

4. Optionally, select Page Setup from the Place menu to set the page size,
orientation, and margin settings.

Note: The page divisions shown on screen are not the same as those of the
printed pages. Use the Print Preview screen to guide you if you wish to print
only selected pages.

5. Optionally, select Print Preview to see how the printed document will be
paginated.  One or two pages can be displayed at a time.  You can also
zoom in to see better detail. Click the Print button in the Print Preview
dialog window to print the set of notes selected (this is the same as the next
step).

6. Select Print from the Place Menu. The print dialog box appears.
7. Choose any option(s) and click OK.

Deleting Notes

Delete notes as follows:
1. Select the note(s) to be deleted.

Note: You can only delete notes which you have written, not notes which others
have written. You are also unable to delete a note if other people have responded
to your note, unless they delete their notes first.

2. Select Edit: Delete Selected Notes or the Delete button.
3. Confirm the selection in the dialog box.

Deleting a Topic
To delete a Topic you will need to delete the note which created the Topic, and
all the notes which have been added in response:
1. Select the Topic to be deleted.
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Note: Because you can only delete notes which you have written, and you are
unable to delete a note if there are responses, you will not be able to delete a
Topic which includes notes from other people, unless they delete their notes
first. (Unless you have Manager Access in Lotus Notes.)

2. Select Edit: Delete Selected Notes or the Delete icon.
3. Confirm the selection in the dialog box.

Finding Notes

You can find all notes with a specific word by using the Edit: Find menu or
selecting the Find button on the right side of the Timeline View window and
entering the word you wish to search for.

You can also search by Topic, by author, by date, by individual selection, and by
content.

The results of the Find will be displayed in the Summary Area.
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How can I Share Documents with Other People?
There are two ways to share a document in Places. You can either attach a
document to a note, or you can put it into the External Document List. Any type
of file can be shared in these ways:

Attaching Documents to a Note

Whenever you create a new Topic or note you can attach a document to the note.
Select the Paperclip button, or the Edit: Attachments… menu item to open the
Attachments window:

Select Add to add files from your computer. When you have finished, click
Close.

 The note will now show this button when there are one or more attachments.
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Viewing Attached Documents

Click the Attached document icon to open the Attachment window:

You can choose to view  a document by selecting Launch, or Save it to your
computer’s disk.

Lotus Notes Content

If a note has been written in Lotus Notes instead of Places, there may be
content, (for instance graphics) which cannot be viewed within Places. To view
the full contents of this note, you will have to open it within Lotus Notes.
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The External Document List

This is a shared folder which enables you to save and retrieve documents to and
from your computer. Put any type of file in the External Document List that you
wish to share with anyone visiting this Place. Each Place has its own List.

1. Add a file by dragging it from the Windows desktop to the External
Document List, or selecting File: Add file to list.

2. To view a document, double click to open it, or select File: Open read-only
copy.

3. Save a copy to your computer to edit by selecting File: Copy to local.
4. Delete a file by selecting File: Delete.

The External Document List is an example of somewhere you could use your
right mouse button to view a pop-up menu.
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How do I find out about other People in the Place?
There are various ways you can find out about the people who are in the Place,
or who have contributed to the Place:
• People Here
• People View
• People List
• Business Cards

People Here shows you who else is in the Place with you (see the Timeline View
for further details). You may want to find out about the author of  a note, or find
out who has contributed most to a Topic. The People View is where you can find
out about people’s interests and expertise. The People List shows you everyone
who has a Lotus Notes account. They might not use Places, but their Business
card will enable you to send an e-mail to their Lotus Notes account.

Wherever you find someone’s name (such as in People Here or the Summary
Area) you can open their Business Card to find out more about them.

Business Cards
Everyone in Places has a Business Card which displays their contact
information, including phone, address and e-mail. The Business Card has both
general information (available from all Places), and specific information
(available from this Place). To display a Business Card (yours or someone
else’s):
1. Double click on a name in the People Here list, or in the Summary Area to

display their Business Card.
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2. You can view information in the following categories:
 

• Main - Gives the person’s name and lists their company’s name and
address, their phone number, job title and department

• Phone - Provides their company and/or personal facsimile, pager, cell
phone and telephone number.

• Contacts - Provides their manager’s name, and their company and
personal home pages, plus (specifically for this Place) a person to
contact if they are unavailable.

• Project - (specifically for this Place) Displays their role, responsibilities
and team members.

• Mail - Lets you send a private email to the person.
• Message - Lets you send a message that is delivered immediately to the

other person, within Places.

Editing your Business Card

To customize or personalize your Business Card, Places provides a Business
Card Wizard .  The Business Card Wizard will display the very first time you
use Places. After that it will also display when you enter a new Place for the first
time to ask you for Place specific information.

To edit your Business Card at any other time, use the Wizard as follows:

1. Select Business Card from the Edit menu.
2. Select All Places or This Place.  The following screen appears:
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3. Follow the Wizard screens to create your Business card, and add bitmap

images and links to web pages and other peoples’ Business Cards.

4. The All Places wizard enables you to add or change the following
information which appears on your Business Card in every Place:

• Company name and address
• Title, department and direct telephone number
• Manager’s name
• Personal and company URL’s
• Company phone and fax numbers
• Further telephone numbers
• Bitmap images for a company logo (200 x 55 pixels), and for your

picture (93 x 100 pixels)
• You can also use the All Places Wizard to redirect your mail messages to

an internet account.
 

5. The This Place wizard enables you to change the information which will
only appear in this place

• Role in the project
• Responsibilities
• A contact if you are unavailable
• Team members
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How can I communicate with other people in the
Place?

To communicate with everyone in the group you can post a note, which everyone
can see. To communicate with an individual you can either send them an instant
message or an e-mail message. Both of these are accessed via their Business
Card, or by using your right mouse button to click on their name in the People
Here window, and selecting Instant Message… or Mail….

Sending Mail

Mail is sent to a Lotus Notes in-box (unless the person has redirected their mail).
1. Open their Business Card (see above).
 

 
 

2. When the Business Card appears, click on the Mail tab.
3. In the Send Mail dialog box, type a subject and the note itself.
4. Click the Send button to send it.  Click the close box or another tab to cancel

your message before it is sent, or to close the card.
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Sending an Instant Message

An instant message is sent to another person within this Place. The recipient of
an instant message will not see the message until they are in the Place you sent it
from, so Instant Messages are most useful to communicate with “People Here”,
or regular visitors.

1. Open their Business Card (see above).
 

 
 

2. When the Business Card appears, click on the Message tab.
3. Click the Send button to send it.  Click the close box or another tab to cancel

it before it is sent.
 

Reading and replying to an instant message

New message are displayed at the bottom of your Places screen as a yellow
block:

1. The number of messages is also shown.
 
2. Messages will remain until you click on the yellow area, when a message

window will appear for each note, showing the sender’s name and the date
and time it was sent:
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3. You can Close the message or select Reply. A window similar to the
message window will open.

4. Type in your reply and click Send.

Note: Instant Messages are not archived. Once you close the message window,
the message is deleted.
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Creating Milestones
Milestones are significant dates for your group, or Project.  You may wish to
create several of them for any given project.  They are shown as a vertical purple
line on the timeline.

Adding Milestones

To add a new milestone, use the following steps:

1. From the Edit Menu select Milestones (or type Ctrl M).  The Milestones
dialog, as shown above, displays any existing milestones and the date when
the milestone occurs.

2. Click on the New button.
3. Enter its title in the Milestone Name box.
4. Enter the date in the date box shown.  Dates must be entered as numbers in

the following format: month/day/year.
5. Click Close.

Using the Milestone Calendar

The date can also be entered by selecting the calendar icon at the end of the date
box.  Do this as follows:
1. Click on the calendar icon to open a monthly calendar which can be used to

easily scroll through dates by day, month or year.
2. Select the date you want by clicking on that date.
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3. To confirm your selection and close the calendar dialog, select the button
with the green check mark.  This enters the chosen date into the milestone
date box.

4. To ignore or cancel the date shown in the calendar, choose the button with
the red cross.  This also closes the calendar dialog.

Note: Choose a Milestone name and date unique to the Place.  If you choose a
name that duplicates an existing milestone, Places assumes you are trying to
modify an existing milestone and warns you accordingly when you try to add
your milestone to the list.

5. Click the Add button.

If the milestone is unique for the date you have chosen, your milestone appears
in the Milestones portion of the dialog.  If, however, you choose a date already
set as a milestone, an error message explains  that only one milestone is allowed
per date.

Modifying an Existing Milestone

1. From the Edit Menu select Milestones (or type Ctrl M).  The Milestones
dialog displays existing milestones and the date when the milestone arrives.

2. Select the milestone from the list shown.
3. Enter a new date in the date box.
4. Click Add.
5. When a new dialog box appears, "Milestone name in Use...", and prompts,

"Commit Changes?" click OK to confirm the new date, or Cancel to ignore
it.
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Deleting a Milestone

1. From the Edit Menu select Milestones.  The Milestones dialog displays
existing milestones and their dates.

2. Select the desired milestone from the list and click the Delete button.  No
confirmation is required.

3. Click the Close button.
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Buttons, Menus and Shortcuts
Places for Project Teams enables you to do things in several different ways. Most actions can be
performed by either selecting from a pull-down menu, clicking on a button, using a keyboard
shortcut, or using your right mouse button to bring up a pop-up menu.

Main Views (by Menu Item)
Action Description Button Menu Item Shortcut /

Pop-Up
Open
Directory

Closes the current
Place and returns you
to the Place
Directory  window.

Place:
Open Directory

Ctrl + O

Home Sets the currently
displayed Place as the
Home Place (An
important Place to
you or one you use
the most).

Place:
Set Current Place
As Home

Ctrl + H

New Topic Creates a new Topic
in the Place Topics
list.

Place:
New Topic

Ctrl + T

Respond to
Topic

Creates a new note
within a Topic when
a Topic is selected
from the Topics List.

Place:
Respond to Topic

Ctrl + R

Exit Exits from the Place
program and closes
all associated
windows.

Place:
Exit

Alt + F4

Select All
Notes

Selects/De-selects all
notes in the current
Place in the Summary
Area.

Edit:
Select All Notes

Ctrl + A

Mark Read Marks the selected
note(s) as read,
(Blue).

Edit:
Mark Read

Shift + Ctrl +
R

Mark
Unread

Marks the selected
note(s) as unread,
(Orange).

Edit:
Mark Unread

Shift + Ctrl +
U

Jump to a
Date

Centers a selected
date in the current
Place timeline.

Edit:
Jump to a Date

Ctrl + J
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Find Allows you to find any
text string.  The results
are displayed in the
Summary Area.

Edit:
Find

Ctrl + F

Business
Card

Allows you to
customize your own
Business Card for this
Place or all Places.
(Refer to Editing your
Business Card) for
more information.

Edit:
Business Card:
All Places
This Place

Milestones Allows you to specify
and name dates for
events..  A milestone is
represented by a
purple vertical bar in
the timeline. These are
visible by all Place
members.

Edit:
Milestones

Ctrl + M

Delete
Selected
Notes

Deletes selected notes
from the database of
the current Place.  You
may only delete notes
you have written.

Edit:
Delete

Timeline
View

Displays the original
timeline or calendar
view.

View:
Timeline View

F5

Newspaper
View

Displays selected
notes (currently
displayed in the
Summary Area) in
newspaper columns.

View:
Newspaper View

F6

People
View

Displays a matrix of
people and their
activity (number of
notes created) in the
current Place.

View:
People View

F7

Outline
View

Shows Topics, notes,
authors, and responses
in a tree structure.

View:
Outline View

F8

Unread
Notes

Displays all the unread
in the Newspaper
View.

+ Ctrl

View:
Unread News

Ctrl +
Newspaper
Button



Buttons, Menus and Shortcuts

3–46    PLACES

People
List

Displays a list of
people you can contact
from this Place.

View:
People List

F9

External
Document
List

Allows you to store or
retrieve documents to
or from the Windows
desktop in the current
Place.  These
documents are
external, shared files
in any format.

View:
External Document
List

F11

Refresh Redraws the outline
view if you select
Cancel initially, or a
note is added to the
Place while you are in
this view.

View:
Refresh View
(in Outline View)

Help Activates the help
system.

Help:
Contents

F1

About Displays information
about the creators of
Places.

Help:
About

Note Window
Action Description Button Menu Item Shortcut /

Pop-Up
Post Saves a newly-written

note or changes made
to an existing note.

File:
Post

Ctrl + S

Discard Cancels a newly-
written note or
changes made to an
existing note.

File:
Discard

Respond
to Topic   

Creates a new note in
the same Topic as the
open note.

File:
Respond to Topic

(Ctrl+Shift+R)

Respond
to Note

Creates a new note
within a Topic which
is linked to this note.

File:
Respond to Note

(Ctrl+R)

Page
Setup

Allows you to set up a
page format for
printing.

Place:
Exit
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Print Allows you to print
using the standard
Windows Print Dialog
box.

File:
Print

Print Once Prints the selected note
one time immediately.

File:
Print Once

Exit Prompts you to save or
discard the current
note and closes the
note.

File:
Exit

Undo Performs a standard
Windows Undo
function of the last
action.

Edit:
Undo

(Ctrl+Z)

Cut Performs a standard
Windows Cut function
of selected text.

Edit:
Cut

(Ctrl+X)

Copy Performs a standard
Windows Copy
function of selected
text.

Edit:
Copy

(Ctrl+C)

Paste Performs a standard
Windows Paste
function of selected
text.

Edit:
Paste

(Ctrl+V)

Attach
File to
Note

Allows you to attach a
document file to a
Note.

Edit:
Attachments…:
Add

Open
Attached
File(s)

Allows you to open a
file attached to a Note.

Edit:
Attachments…:
Launch

Save
Attached
File(s)

Allows you to save a
file attached to a Note
to your computer.

Edit:
Attachments…:
Save

Delete
Attached
File(s

Allows you to delete a
file attached to a Note.

Edit:
Attachments…:
Delete

Plain text Returns selected text
to plain text.

(Ctrl+P)

Bold Makes selected text
Bold.

(Ctrl+B)

Italic Makes selected text
italic.

(Ctrl+I)



Buttons, Menus and Shortcuts

3–48    PLACES

Underline Underlines selected
text.

(Ctrl+U)

Strikeout Puts a strikeout
character through
selected text.

(Ctrl+K)

Bullets Makes the selected
text into a bulleted list.

(Ctrl +T)

Color Sets the color of the
selected text to red,
blue or the default
color.

Using the Mouse
Left button,
single click

Left button,
double click

Right button

General Action Select. Open. Pop-Up Menu.

Timeline View Selects a single note
block and pins flyover
list.
Selects whole Topic.

Opens Newspaper
View for selected
notes.

Status Area Selects a single note.
Toggles sort by
alphabet, date, author,
attachments.

Opens a selected
single note in the
Note Window.

Newspaper
View

Selects text for cut and
paste. On scroll
buttons: scroll by line,
note or page.
Shift + Click to
highlight text across
columns.

Selects a whole word
(triple click selects a
whole paragraph).

People View Selects a cell to view
notes in Summary
Area.

Opens Newspaper
View for all notes in a
selected cell.

Outline View Collapses and expands
note hierarchy.
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If I Need More Help
Places has a Help system that you can access at any time while running the
software by selecting Help: Contents, or using the F1 key.

If your questions are not answered in the Help System or this User Guide, then
check the FAQ (Frequently Asked Questions), or the Places Newsgroup, which
can both be found at http://www.taligent.com. You may post any question or
comment to the Newsgroup and the Places team will respond.

During our 1997 Places 1.0 product introduction, you may also send your
questions or requests privately at no additional charge.  Use the form available
on the Taligent website at www.taligent.com/places.  Or, if you prefer, you may
send an email to places_support@taligent.com.  In either case, a member of the
Places team will respond directly to you.
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Paste, 47
PDS, 7, 9, 11, 12
People Here, 14, 35
People List, 35, 46
People View, 13, 21, 24, 35, 45
Phone tab, 36
Place Maker Wizard, 7, 9

Places Newsgroup, 49
Places Product Sheet, 8
Plus symbol, 22
Post, 28, 46
Print, 47
Printing, 29

Multiple Notes, 29
Print Once, 29, 47
Print Preview, 30
Selected Pages, 30
Single Notes, 29

Processor, 4
Project tab, 36
Pull-down menus, 44

R
Read Notes, 16
Reading a Note, 24
Reading Multiple Notes, 19
Redirecting your Mail Messages, 37, 38
Refresh, 8, 46
Responding to a Note, 27, 46
Responding to a Topic, 26, 44, 46
Right mouse button, 44

S
Sample places, 5, 7
Scrolling the Newspaper text, 20
Set Current Place As Home, 46
Setup.exe, 5
Shared Places, 9
Sharing Documents, 32
Sorting Notes, 18
Start Menu, 7
Starting Places, 7
Summary Area, 18, 24, 35
System disk, 4

T
Text

Bold, 47
Bullets, 48
Color, 48
Italic, 47
Plain, 47
Strikeout, 48
Underline, 48



Index

User Manual    3–3

Timeline Area, 15
Timeline View, 13, 14, 24, 45
Topics, 21, 26
Topics Area, 17

U
Undo, 47
Uninstall, 5
Unread News, 25
Unread Notes, 16, 19, 30, 45

Unread Only, 18, 25

V
Vertical purple line, 15

W
Writing a note, 26


